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Module 
Title: Changing Family Forms in the U.S. from 1970 to 2010  

Course: SOCI 169gm: Changing Family Forms  
Summer 2015 

 
Sandra M. Florian 

Sociology Department 
University of Southern California 

 
Description: This module introduces students to recent trends in households and family forms, 
and provides data to examine how family types differ by class and race/ethnicity. 
 
Objectives 
Substantive 

1. Learn how to describe households and families using demographic and socioeconomic 
terms. 

2. Examine trends in changes in family forms of Americans from 1970 to 2010.  
3. Profiling own family in demographic and socioeconomic terms and compare it with U.S. 

averages. 
4. Use sociological perspective and sociological research to provide relevant explanations 

for these events and characteristics. 
5. Make some predictions for future families in the U.S. and for own family members using 

sociological theories and empirical findings from lecture and class readings. 
 
Methodology/Skills 

1. Using data to tell a story: Learn how to read and interpret graphs and tables displaying 
frequencies and percentages.  

2. Use charts and tables to identify patterns. 
3. Improve student’s confidence in reading and discussing data from tables and graphs. 
 

Day 1 
 
Definitions 
 
• Household: a group of people that lives and eats separately from other groups. 

• Family: 3 definitions (Cohen (2015), The Family, pp. 6-11) 
a) Personal family: People to whom we feel related and who we expect to consider us 

members of their families. 
b) Legal family: a group of individuals related by birth, marriage or adoption (Census) 
c) Institutional family: institutional arena where people practice intimacy, childbearing, 

socialization, and caring work. 
 
• Breadwinner-homemaker family (sometimes called “traditional family”): An employed 

father, a nonemployed mother, and their children. 
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For discussion: Yes or No questions 
 

• Do people living alone constitute a household? _____  a family?_____ 
• Do unrelated students living together constitute a family?____ a household? ____ 
• Does a mother living with her child constitute a family?_____ a household? ____ 
• Are all households families? _____   Are all families households? _____ 
• A girl living with her aunt constitute a family?____  

 
 
[Take pre-assessment before examining Figure 1] 
 

Figure 1. Households by Type: U.S. 1970 – 2010 
 

 
Source: U.S. decennial census 1970-2000 and American Community Survey (ACS) 2010. 

 

Exercise 1: Describe trends in households using Figure 1 
 
• What percent of households were married couples with children in 1970? _____  In 2010?_____  

• Approximately what percent of households were families in 1970? _____  In 2010?_____  

• What percent of households were married couples in 1970? _____ (69%) In 2010?_____  

 
Describe the trends in household types in the U.S. from 1970 to 2010 

______________________________________________________________________________ 

______________________________________________________________________________ 

______________________________________________________________________________ 
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Figure 2. Families with own Children by Type and Employment Status of Parents: 
U.S. 1970 – 2010 

 

 
Source: U.S. decennial census 1970-2000 and American Community Survey (ACS) 2010. 

 
• How would you describe your own family type? 

 
Exercise 2: Families with own children  
 
Describe the trends in families with own children in the U.S. from 1970 to 2010 using Figure 2: 

______________________________________________________________________________ 

______________________________________________________________________________ 

______________________________________________________________________________ 

 
• What was the most common type of family with own children in 1970? 

__________________________________________   

• What was the most common type of family with own children in 2010?   

__________________________________________   

• Approximately, what percent of families with own children were single mother families in 

1970? _____  In 2010?_____  
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Day 2 
 
Exercise 3: Describe families by race/ethnicity and class. Examine frequencies and 
percentages. 
 
Dataset: Family.dat, ACS 2010.  
Universe: Families in the USA. 
Source: http://www.ssdan.net/datacounts 
 

Table 1. Race/Ethnicity Distribution of Families 
 White Black Asian Hispanic Other Race 
% 69.0 11.5 4.6 12.9 2.0 
Freq. 52,566,312 8,733,232 3,497,406 9,866,106 1,546,783 

 
Note: Racial groups in this dataset are mutually exclusive categories, thus White means Non-
Hispanic White, Black is Non-Hispanic Black, etc. Thus, in the U.S. 52,566,312 families in the 
US in 2010 were Non-Hispanic white, which represents 69.0% of all families. Generally, for 
comparison purposes, we talk about percentages, rather than raw numbers.   
 
Description: We see that 69% of U.S. families in 2010 were White, nearly 12% were Black, 
about 5% were Asian, 13% were Hispanic, and 2% were other race. 
 
Now describe the following tables: 

 
Table 2. Poverty Level Distribution of Families 

 
 Poverty Near Poor Middle Comfortable 

%  10.6 7.7 49.9 31.8 
Freq. 8,061,026  5,859,272  38,049,728  24,239,792  

 
______________________________________________________________________________ 

______________________________________________________________________________ 

 
Table 3. Distribution of Family Types 

 Married Couples Female Families Male Families 
% 73.9 19.2 6.9 

Freq. 56,326,264 14,622,836 5,260,724 
 
______________________________________________________________________________

______________________________________________________________________________ 
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Answer the following questions: 

• What percent of families were poor? ____________ 

• What percent of families were poor or nearly poor? ____________ 

• What percent of families were married couples? ________ Female-headed families? _______ 

 
Exercise 4: Explaining racial/ethnic differences in family types using bivariate analysis 
(crosstabs). 

 
 

Table 4: Family Type by Race/Ethnicity 
 White  Black  Asian  Hispanic  Other Race  TOTAL  
Married Couples  80.6%  44.4%  81.0%  63.7%  62.6%  73.9%  
Female Families  13.8%  46.3%  12.6%  25.0%  27.8%  19.2%  
Male Families  5.6%  9.3%  6.4%  11.3%  9.6%  6.9%  
TOTAL  100%  100%  100%  100%  100%   

 

True or false? 

• 46.3% of female-headed families are black? True____ False___ (F) 

• 46.3% of black families are female-headed families? True____ False___ (T) 

• Married couple families are more common among Asians? True____ False___ (T) 

 
Describe the patterns you see in Table 4: 

______________________________________________________________________________

______________________________________________________________________________ 

______________________________________________________________________________ 

 
What factors may explain racial/ethnic differences in family type?  

______________________________________________________________________________ 

______________________________________________________________________________ 
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Table 5: Family Type by Poverty Level 

 
 Poverty Near Poor Middle Comfortable TOTAL 
Married Couples   36.3%  54.2%  74.5%  90.2%  73.9%  
Female Family  53.5%  35.4%  17.8%  6.0%  19.2%  
Male Family  10.1%  10.4%  7.7%  3.8%  6.9%  
TOTAL  100%  100%  100%  100%   

 
Table 6: Poverty Level by Race/Ethnicity 

 
 White Black Asian Hispanic Other Race TOTAL 
Poverty  6.6%  22.1%  8.8%  21.0%  17.0%  10.6%  
Near Poor  5.6%  12.0%  7.3%  14.9%  10.6%  7.7%  
Middle  50.2%  49.0%  45.1%  51.1%  50.2%  49.9%  
Comfortable    37.6%  16.9%  38.9%  13.0%  22.2%  31.8%  
TOTAL  100%  100%  100%  100%  100%   

 

Describe the patterns you see in Table 5. From lecture and readings why low-income people are 
less likely to be married? 
 
______________________________________________________________________________

______________________________________________________________________________ 

______________________________________________________________________________ 

 
Describe the patterns you see in the Table 6. What can you infer from the relationship between 
race/ethnicity and poverty and the variations in family types?  
 
______________________________________________________________________________

______________________________________________________________________________ 

______________________________________________________________________________ 

 
Now analyze the relationship between age and family type: 
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Table 7: Family Type by Age 
 16-25 25-34 35-44 45-54 55-64 65+ TOTAL 

Married Couples  41.1%  65.3%  70.9%  74.9%  82.7%  81.0%  73.9%  
Male Fam  17.8%  9.4%  7.4%  7.0%  4.7%  4.1%  6.9%  
Female Fam  41.1%  25.3%  21.7%  18.1%  12.6%  14.9%  19.2%  
TOTAL  100%  100%  100%  100%  100%  100%   

 
Table 8: Age by Race/Ethnicity 

 White Black Asian Hispanic Other Race TOTAL 
16-25  2.2%  4.7%  1.9%  5.5%  5.0%  3.0%  
25-34  13.5%  19.2%  17.4%  24.7%  20.8%  15.9%  
35-44  20.2%  25.1%  28.7%  29.1%  25.2%  22.4%  
45-54  24.0%  23.3%  24.9%  21.3%  23.1%  23.6%  
55-64  19.7%  15.2%  16.2%  11.3%  15.2%  17.9%  
65+  20.3%  12.5%  11.0%  8.1%  10.6%  17.2%  
TOTAL  100%  100%  100%  100%  100%   

 
 
Which age groups are more likely to be married? Which racial/ethnic group is more represented 

in those age categories? Can you add another explanation for why we observe large racial 

variations in family forms?  

 
______________________________________________________________________________ 

______________________________________________________________________________

______________________________________________________________________________ 

 
Conclusion: 
 
______________________________________________________________________________

______________________________________________________________________________ 

 
Feedback: 
 
What is the most useful thing you have learned from this assignment?  
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______________________________________________________________________________

______________________________________________________________________________ 

 
Do you have any suggestions to improve this assignment? Would you change anything? 
 
______________________________________________________________________________

______________________________________________________________________________ 

 
******************* 
Instructions on how to get data for exercises 3 and 4. 
 
Dataset: Family.dat, ACS 2010.  
Universe: Families in the USA. 
 
Variables: 

• RaceEth: NHWhite (Non-Hispanic White), Black, Asian, Hispanic, OtherRace. 
• Kid: None, Kids6 (Has kids under age 6), KidsOther (Has kids 6+) 
• AgeAll4: 25 (age16-25), 25-34, 35-44, 45-54, 55-64, 65+ 
• PovLevel: Poverty (below poverty threshold), NearPoor (100-150% of poverty threshold), 

Middle (151-400%), Comf (comfortable: 401+%). 
• FamType: MrrdCpl (Married couple), MaleFam (Male-headed family), FemFam (Female-

headed family) 
 

1. Go to http://www.ssdan.net/datacounts 
2. On the “Home” tab, scroll down and click on “Datasets”. 
3. On the “Choose a Collection or Dataset” box, find “acs2010” in the drop-down box, 

select it, and click “submit.” 
4. Scroll down through the list, select “Family.dat” and click “submit.” 
5. Click on “WebCHIP 3.0”  (Note: need to have java installed) 

 
Exploring the dataset: 

6. Go to “Modify” tab, select “Combine”. Select (Control+click) “AmIndian”, “NHOther”, 
NHMulti”, OK, name it “OtherRace” 

7. Go to the “Command” tab, click on “marginals.” It will give you frequency distribution 
tables for all the variables in the dataset. 

 
Bivariate analysis using crosstabs 

1. Go to the “Command” tab, click on “crosstab”. For Row, scroll down and select 
“FamType”. For column, select “PovLevel” (or other variable). 

2. To obtain frequencies for the crosstab you just created go to the “Table” tab and select 
“Frequencies”.  

3. To obtain percentages go to the “Table” tab and select “Percent Down” 

http://ssdan.net/cgi-bin/webchip/webchip3-beta.cgi?webchip=datasets/pc/acs2010/Family.dat

